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Long, long ago, Adobe gave us transparency in 
InDesign version 2, and it was good. Not great,  
but at least a step in the right direction. Designers  
reveled in the ability to add drop shadows and 
feathered edges to objects directly in InDesign.  
It wasn’t until those early adopters tried to  
print documents with those new effects—and  
often failed—that they realized transparency could  
be problematic. 

With each subsequent version of InDesign, 
Adobe has added ways to enhance documents with 
transparency, making it even more enticing. The 
Flattener Preview panel debuted in the first Creative 
Suite. In CS2, Adobe improved compatibility with 
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native Photoshop and Illustrator files. And in CS3, 
there are a host of new effects, such as gradient and 
directional feathers and inner and outer glows.  
(You’ll find these and more on the Effects panel, 
known as the Transparency palette in earlier versions). 
There’s one thing that hasn’t changed, however,  
and that’s the need to flatten transparency for output  
to a PostScript device. Until the day comes when 
flattening is no longer required (in fact, that day is here 
in some spots already, as we explain in the sidebar 
“Workflow Of The Future”), it’s essential for everyone 
involved to understand why flattening may be 
necessary and how it doesn’t have to spoil the good 
looks of your original documents. 

Now your designs can reap the
              rewards of transparency effects
      without fear of repercussion.
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Always ask your print shop what PostScript level they’re 
using to output an InDesign document before you 
submit it. Some shops prefer that you submit InDesign 
files as PDF/X files, which are flattened; while others 
may prefer you to submit an unflattened InDesign or 
PDF 1.4 (or later) file.

Flattening Isn’t a Four-Letter Word
Anyone who has used transparency in InDesign knows 
what it can do for a layout. Transparency breathes 
life into a design; it adds shadow and light, depth 
and dimension (Figure 1). By definition, transparency 
admits the passage of light and permits a clear view of 
objects beyond. The term flattening is rather obscure, 
however. 

To better understand the purpose of flattening, 
let’s start with a simple fact: Transparency requires 
flattening when saving or exporting to a format that 

doesn’t support it (such as PDF 1.3, EPS and DCS) or 
printing to a PostScript raster image processor (RIP). 
Here’s another fact: Once you’ve flattened transparency, 
it’s no longer “live”—you can’t edit it.

Many issues surround transparency because 
sometimes the flattening process produces unwanted 
artifacts that don’t appear in the original art. After 
flattening, parts of lines or other vector objects 
might rasterize; portions of text might look chunky 
or pixilated; there might be noticeable shifts in color 
between raster and vector elements (called stitching); 
or you might get unwanted white boxes surrounding 
transparent elements. These ill affects of flattening 
are all unacceptable, but they’re also explainable and 
preventable. 

At this point, you may be thinking, “I just won’t 
use transparency in my documents. Then I won’t have 
to worry about the affects of flattening.” Easier said 
than done. You might, for example, place a native .ai 
Illustrator or .psd Photoshop file that contains live 
transparency into your document. And if you avoid 
transparency entirely, you’ll miss out on opportunities 
to take your designs to the next level. 

Figure 1: Transparency is behind the simplest effects, such as the 
drop shadow in this layout.
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Tip

Imagine a time when flattening transparency in PDF 
files is no longer necessary for print. The inherent 
issues associated with flattening are nothing more than 
distant memories, and designers and print vendors work 
harmoniously in a PDF workflow. For some, this is a dream 
already come true thanks to Adobe’s latest PDF raster 
image processor (RIP) technology. 

The Adobe PDF Print Engine is a relatively new printing 
platform being incorporated by OEMs (original equip-
ment manufacturers) into printing products, such as  
RIPs, previewing and proofing software, and workflow 
systems. The Adobe PDF Print Engine allows PDF docu-
ments to remain unconverted and independent of print-
ing devices throughout the print workflow. There’s no 
need to flatten transparency at any stage—previewing, 
proofing, or printing.

The Adobe PDF Print Engine uses JDF (Job Definition 
Format) to capture and control process information. (For 
more on JDF, see the article on page 24.) This makes it 
possible to decide at the last minute where to print a job, 
eliminating scheduling delays or the need to rework the 
file to accommodate a different device. The RIP applies 
trapping and other settings specified in the JDF file, and 
the PDF file remains flexible throughout the process.

This may sound too good to be true, but Sells Printing 
Company in New Berlin, Wisconsin, offers proof. Sells staff 
have been working closely with Adobe InDesign since prior 
to version 1.0’s release. When Sells decided to upgrade to 
the Kodak Prinergy 4.0, the Adobe PDF Print Engine came 
as part of the package deal. Sells has been using the new 
workflow system since August 2007 and now prefers it to 
a standard PostScript workflow. “We liked the results more 
and more,” says James Wamser, Adobe certified instructor 
and print specialist at Sells, “and now we love it.”

In both new and traditional PDF workflows, Wamser 
says they encourage their customers to submit InDesign 
CS3 files as PDF/X-4 standard PDF files. Sells recommends 
that customers using InDesign CS2 create Adobe PDF 
1.4-compatible files for the live transparency component. 

In any case, it’s important to ask your printer how they 
prefer you to submit PDF files. Wamser also recommends 
sending test files. 

Workflow of the Future



3
M A G A Z I N E 	 22	 February | March 2008

Behind the Scenes
InDesign uses its own flattening technology to convert 
transparency to a form PostScript understands. It does 
this by cutting apart overlapping areas of transparent 
objects—including text and graphics that interact 
with transparency—and rendering them opaque. For 
example, where two transparent objects overlap, the 
flattening process breaks the art into several distinct 
pieces: the two objects and all the areas that overlap 
(Figures 2 and 3). Although this creates an opportunity 
for error, you can achieve perfect results every time with 
the correct flattener settings and careful page layout. 

Predetermine Results
The Transparency Flattener in InDesign determines 
how the application will flatten transparency. It’s a 
tool of power—and possible peril. Always discuss 
flattening with your print vendor, and don’t take 
on this task unless given consent and the proper 
specifications.

Choose Edit > Transparency Flattener Presets 
to take a closer look. Select a preset in the Presets 
window to view its settings in the Preset Settings 
window (Figure 4). There are three default presets:

Low Resolution❱❱ : Rasterization occurs when 
necessary and at a suitable resolution for desktop 
printing. InDesign converts to outlines strokes and 
text that interact with transparency.
Medium Resolution❱❱ : Rasterization occurs when 
necessary and at a suitable resolution for laser 
printing. InDesign clips complex regions.
High Resolution❱❱ : InDesign rasterizes vector objects 
only if absolutely essential and at a resolution 
suitable for offset printing.

You can’t edit these default presets, but you can 
create your own when necessary. Simply click the New 
button (Figure 5) to access the following six options:

Raster/Vector Balance: ❱❱ This slider controls how 
liberal InDesign is about rasterizing complex 
regions (where there are many overlapping objects 
affected by transparency). A number closer to 0 
gives InDesign more freedom to rasterize at will, 
resulting in faster print times. A number closer to 
100 restricts rasterization but increases print time. 
Set at 100, InDesign doesn’t rasterize objects simply 
for performance reasons. In cases where files are Figure 2: Artwork with transparency applied.

Figure 3: Flattening cuts apart the affected areas and  
renders them opaque. 
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Figure 4: You can choose one of three default Transparency 
Flattener presets or create your own.

Adobe recommends working with native file formats 
to preserve any live transparency in files you place in 
InDesign. This workflow not only lets you continue 
editing transparency effects in placed graphics, it can 
also improve final results.

Tip
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taking extremely long to print (or crashing the RIP 
altogether), however, consider adjusting this slider to 
a slightly lower setting. 

Note that InDesign also rasterizes regions when 
there is no way to preserve their appearance in vector 
form—such as when a photo with a soft drop shadow 
overlaps a background. The drop shadow is a raster 
effect and the background is a vector object. The only 
way to preserve the effect in PostScript is to rasterize 
the background with the drop shadow. 

Line Art and Text Resolution: ❱❱ InDesign either 
converts to outlines or rasterizes line art and text 
affected by transparency. To ensure quality output, 
set the appropriate resolution for the intended 
output device. The High Resolution preset, for 
example, specifies a resolution setting of 1200 
ppi—appropriate for commercial printing. 
Gradient and Mesh Resolution: ❱❱ InDesign uses this 
setting to rasterize elements that can afford to be 
set at a lower resolution. Gradients and meshes (the 
resolution of drop shadows and glow effects) are 
continuous tone, so they don’t require a resolution as 

high as line art or text. In fact, anything twice the line 
screen for the intended device is probably getting 
thrown out anyway. The High Resolution preset uses 
a value of 300 ppi—typical for commercial printing. 
Convert All Text to Outlines: ❱❱ Rasterized text can 
look a bit chunkier than regular vector text. To 
compensate, you can turn on this option to convert 
all text to outlines, giving a consistent, chunkier look 
to all of your text—not just the text that interacts 
with transparency. 
Convert All Strokes to Outlines: ❱❱ Similar to the 
previous setting, this compensates for disparity 
between vector and rasterized strokes by converting 
all strokes to outlines. 
Clip Complex Regions: ❱❱ Raster images are always 
rectangular in shape, which means it’s possible  
for innocent bystanders to become rasterized simply 
because they intercept a complex area. More  
often than not, this results in stitching or noticeable 
white boxes and color shifts (primarily when  
output on a medium-resolution device). The Clip 
Complex Regions option limits this by creating a 
clipping mask around rasterized complex regions,  
so the rectangular-shaped raster is masked by  
the vector outline of the object. This makes for  
even more complex files and can result in longer 
print times.

Once you’ve finished tweaking these flattening 
options, name your new preset and click OK. The new 
preset displays in the Transparency Flattener Presets 
dialog box. Or, you can load external preset files, which 
some print shops supply. The presets in this dialog 
box are also in the Preset pop-up list on the Advanced 
panel, in both the Print and Export To PDF dialog boxes. 

Seeing Is Believing
The easiest way to tell if there’s transparency in an 
InDesign document is to look at the Pages panel. 
Pages with transparency effects display a small 
checkerboard pattern icon just below their page 
icons (Figure 6). (Versions earlier than CS3 display a 
checkerboard pattern on the page icons.) That’s great, 
but how do you know if a layout has complex regions 
or text that will be rasterized? InDesign has something 
called the Flattener Preview panel. Simply choose 
Window > Output > Flattener Preview and you can 
see how InDesign will flatten transparency in your 
document. 

This preview palette is more than just a handy way 
of seeing what InDesign is doing. It’s also a tool you 
can use to help make adjustments to your files or your 
flattener settings for better results—all before you 
spend time and money printing film or plates. You can 

Figure 6: Pages with transparency 
on them display a small 
checkerboard pattern icon just 
below their corresponding page 
icons in the Pages panel.

Figure 5: When you create a new Transparency Flattener preset, you 
can specify how InDesign flattens transparency.

T YR CRA EAPN NS
The best way to preserve the appearance of 
text is to position it on its own layer above all 
other layers. This prevents the text from being 
converted to outlines or rasterized during 
flattening. 

Tip
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preview the following in the Flattener Preview panel:
Rasterized Complex Regions❱❱
Transparent Objects❱❱
All Affected Objects❱❱
Affected Graphics❱❱
Outlined Strokes❱❱
Outlined Text❱❱
Raster-fill Text and Strokes❱❱
All Rasterized Regions❱❱

For example, choosing Transparent Objects 
from the Highlight list shows you the location of all 
transparent objects on the active page or spread.  
To see which elements will be affected by 
transparency, choose All Affected Objects from the 
Highlight list, and then choose the preset you want 
InDesign to use to output the file from the Preset list 
(Figure 7).

If you choose All Rasterized Regions and see that 
certain text is affected by a nearby or overlapping 
transparent object, you can make an adjustment in 
your layout to avoid the text from being rasterized or 
converted to outlines (Figure 8). And if you see that 
InDesign is being too liberal about rasterizing complex 
regions, you can make an adjustment to the Raster/

Figure 8: You can preview whether text will be rasterized or 
converted to outlines and then do something about it.   

Figure 7: Use the 
Flattener Preview 
panel to see where you 
might need to adjust 
your layout to prevent 
unwanted flattening.
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Other useful tools are Overprint Preview (View menu) 
and Separations Preview panel (Window > Output 
> Separations Preview). Both enable you to proof 
documents onscreen to see if flattening will have an 
adverse effect on the colors in your document.

Tip

Cacidi LiveBrowse is your visual file-
browser, which makes it so simple 
to browse through your files, and 
easily drag the image or text file 
to your document. All placeable 
file can be viewed in four different 
preview sizes, up to 200x200 px 
– great quality makes it easy to 
choose the right file!

LiveMerge allows you to create and 
re-use design group objects – and 

totally innovating – receive a 
live feed of text and images from 
your mySQL database or text file. 
Focus on design and layout and 
let LiveMerge control the content 
in your document - live updating 
right in front of your eyes. No 
need for checking if your docu-
ment content is up to date, Live-
Merge handles that part for you! 

Download a trial version at www.cacidi.com

CS3
Ready

InDesignMag.indd   1 3/30/07   12:22:52 PM

http://www.cacidi.com
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Vector Balance setting in a the custom preset that 
will be used to output the file. Choose Transparency 
Flattener Presets from the Flattener Preview panel 
menu to make quick and easy adjustments to a 
custom presets.

Know Thy Print Standards
As we mentioned earlier, the PostScript level and PDF 
compatibility of the intended output device play a 
huge part in how transparency is handled in your 
InDesign documents. All PDFs are not created equal! 

If you intend to export your InDesign document 
to PDF, make sure that you select the correct standard 
and/or compatibility option in the Export To PDF 

dialog box (Figure 9). PDF/X-4:2007 is the latest 
standard and Acrobat 8 (PDF 1.7) is the latest format 
(available only in CS3). PDF/X-4 supports transparency 
in addition to everything its predecessors support, 
such as spot color and  color management. Acrobat 
5 (PDF 1.4) and later also supports transparency. 
However, not every print shop has upgraded its 
equipment to these latest standards and formats, 
which is why we’re having this conversation in the first 
place. Ask your print shop for the preferred standard 
and format.

And In the End
Designing with transparency lets you create layouts 
that used to be difficult to implement, allowing you 
to save valuable time while being even more creative. 
Now that you know how transparency works and 
what’s necessary to use it in your workflow, give it a 
try. You’ll be happy you did. 

MORDY GOLDING� is the author of Real World Adobe Illustrator CS3 
and SAMS Teach Yourself Adobe Creative Suite 3 All in One. You can find 
Mordy online at his blog or at www.mogo-media.com. 

RENÉE DUSTMAN� is a freelance writer and graphic designer 
and the former editor in chief of Inside Adobe InDesign.

Figure 9: The Standard and Compatibility options play a major role 
in how transparency is handled in your documents.
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Before printing or exporting an InDesign document, 
look at the Edit > Transparency Blend Space menu and 
make sure the correct blend space is selected. 

Tip

The Perfect Complement to InDesign Magazine!

Visit our free:

plus: 
free plug-ins:  

http://www.amazon.com/exec/obidos/ASIN/0321496213/creativeprocom
http://www.amazon.com/exec/obidos/ASIN/0672329344/creativeprocom
http://rwillustrator.blogspot.com
http://www.mogo-media.com
http://www.indesignsecrets.com
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CreativePro.com readers, you get a special 
price. Go to www.indesignmag.com/
purchase.php and enter the discount code 
“cp” to receive a 1-year subscription for 
$39, or a 2-year subscription for $69. 
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